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Automated Delayed Order Report (DOR) User Manual

Overview

I ntroduction

Working Days

Record Status

June 2003

The Delayed Order Report (DOR) User Manual correspondsto Patch
RMPR*3*59. This patch provides Prosthetics GUI (graphical user interface)
windows for the Delayed Order Report (DOR) feature.

Note: Using thisfeaturerequiresbasic MS Windows skills.

The Prosthetics users will be able to do the following with this patch:

Search for and display manual suspense entries/electronic consult (CPRS order)
data by one or al sites.

Display data using one or multiple statuses (Open, Pending, Cancelled or
Closed).

Use a starting date for Closed and Cancelled records to display data.
Sort and rearrange the view; display datain a custom view.
Print the display.

Convert the display into a Microsoft Excel file (for more sorting capabilities).

A delayed order is counted in Working days not Calendar days. Thisdoes NOT
include Saturdays and Sundays or Holidays!!!

The Status column shows the following status types:

1. Open
2. Pending
3. Closed
4, Cancdled
Continued on next page
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Overview, Continued

Statuscycle

Work Days, not
Calendar Days

June 2003

The Initial Action Date displays the date of the first action taken on the suspense
entry/electronic consult (CPRS order) record. This changes the status from OPEN to
PENDING. An order remainsin PENDING status until it is fulfilled and then
changesto a CLOSED status.

Note: The status can change from OPEN to CLOSED if the order has been fulfilled
upon the initial action.

Keep in mind that when creating the first action note, the status changes from OPEN
to PENDING and when creating the second or additional action note(s), the status
remains PENDING. Only when arecord is completed does the status change to
CLOSED.

When a complete note is posted, all action has taken place for arequested Prosthetic
item or service. When you post the complete note, the status on the record changes

from PENDING (if action has previously taken place on the request) or OPEN to a

CLOSED status.

The Delayed Order Report displays the number of “Work" days (not Calendar
days) from the original date the order was entered as an electronic consult or a
suspense entry to the day it is completed. A “Work” day is defined as Monday
through Friday.

Note: The calculation subtracts Saturdays and Sundays and Holidays from the
number of days the order was entered, even if a CPRS order was written over a
weekend. Holidaysare NOT counted.

Prosthetics Automated Delayed Order Report (DOR) User Manual
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Display the DOR Data

Introduction

General steps To utilize the Delayed Order Report (DOR) data, hereis a general set of stepsto
toview DOR display DOR data as follows:
Data

1. Select ALL sites by checking the “Or...All Sites’ checkbox (or you can
select a specific site from the drop down list).
Enter a Starting Date (defaults to the current date).
Select a Statusif you want to change the default statuses. The default
statuses are set to Open, Pending, and Closed.
4. Enter the SSN range of the patient display (mandatory).
5. Click the Display button.

2.
3.

Description The Description is afree-text field that is manually entered with approximately 15
charactersin length. If you can’t view the entire description, you can expand the
column by clicking and dragging the borderline to a wider position.

Datadisplayed Thedatathat is displayed with this GUI feature includes the following:

Grid Columns:

e Site

Delayed column (Yes or No)

Status of the order

Type of Order —Manual Suspense or Routine (electronic orders via CPRS
including Eyeglass, Contact Lens and Home Oxygen orders)

Station number

Create Date (Suspense entry date)

First Action Date — Date that the order was put into PENDING status
Number of Days that the order has been delayed including columns for: 0-5, 6-
9, 10-29, 30-90, and 90+ columns

Link information — linked message(s) to the order record

Brief description

Patient name

Socia Security Number

Fields:
e Selection Result Totals (near bottom of window) include:

» Tota records found
» Total delayed records by calculation
» Percent delayed records by calculation

June 2003 Prosthetics Automated Delayed Order Report (DOR) User Manual
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Select a Site(s)

Select Site

Steps

DOR window

Select “ALL
Sites’

June 2003

Thefirst thing you must do to view the DOR isto select a site for the records that
you want to display. If you are a multi-site facility, you will be able to select the
specific site you want to view viathe drop down box. Recommendation: Itis
highly recommended that you select the “Or ... All Sites’ checkbox.

To begin the process to display the DOR data, follow thisfirst step:

Step Action

1 Click the“Or...All Sites’ checkbox to view ALL sites and CBOC data.

= Delayed Order Report . .. You are logged onto brokerserver = |E||1|
File Select & Display Yiew Help

Please select . . . A Site: m Or ... all Sites:[ll A Starting Date: m

- ATLANTA VAMC .
The Status: g l]pen_ CORKWELL WAME N _ )
| Pending HIMESTEST last two digits of the . .. Starting SSN: @ . . . Ending S5N: E

[ /Dlyd [status [rype 5| HINESTEST Lo~ e li0-2a[30-59 o0+ liok |pescription ___|patiert Sohy

Hines Development Sypstem
Hines Development System?
SAN AMTOMIO VAMC
2204 WAMC VAMC

&' 2319 | " DOR Detail | Total Humber of Records -» 0 3% Excel | % Refiesh |
&a" CPRS | &d" Pending Calc | Total Humber of Delayed Orders -> 1] @ Print | x Clear |
&' Request | Percent of Delayed Orders -> | 00.00 @ Menu |

If you want to view all available suspense entries/el ectronic consult orders including
Community Based Outpatient Clinics (CBOC) data, click the All Sites checkbox
instead of selecting your specific site from the Site drop-down list box. This ensures
that the display will include all sites. For example, the Kenosha, Wisconsin CBOC
will not display when the Milwaukee site is selected only. These records display
when the All Sites checkbox is selected.
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Select a Starting Date

Date/Calendar  Note the Starting Date defaults to the current date. Y ou can change this date. Enter
a Starting Date by clicking on the drop-down list box. A calendar displays with the
current date circled in red and shown at the bottom of the calendar. Y ou can accept
the current date by clicking on it.

Steps To continue to display the DOR data, follow this step:
Step Action
2 Enter a Starting Date (defaults to the current date).
Date Y ou can change the date by the following methods:
Changethe... Description
Day Click on the actual day of the week in the calendar.
Month Click on the month at the top of the calendar to display alist

of all months and select one. Or you can decrease or increase
one month at atime by clicking the left or right arrows.

Y ear Click on the year and an up and down arrow button displays
for you to increase or decrease the year.

Star tl ng date == Delayed Drder Report . .. You are logged onto brokerserver - |E||1|

File Select & Display Wiew Help

calendar
Please select ... A Site: ‘ Or... All Sites: [l A Starting Date: m
The Status: [ Open Bl Cancelled [ < | June, 2003 [+ | !I
& Pending & Closed The last two digits of the . . . Starting 55M: Em S Mon Tue 'wed Thu i
| Divd [Status _|Type __lstation [Creste [1st action |05 69 [10~2930~89 |50+ ink [Descrinti
1 2 @4 5
g 9 1 11 12
1% 16 17 18 19
2 023 24 % %
23 30
< 3 Today: 6/3/2003
/2019 | 67 DORDetail | Total Number of Records > [ 0 3 Excel | £3Refiesh |
&d" CPRS | &d" Pending Calc | Total Humber of Delayed Orders -> o @ Print | x Clear |
64" Request | Percent of Delayed Orders -> | 00.00 @ Menu |
|Se|ect a Pending Start date
June 2003 Prosthetics Automated Delayed Order Report (DOR) User Manual
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Select a Status

Status

Steps

Status
Scenarios

June 2003

Y ou can view Open, Pending, Closed or Canceled records by clicking the
checkbox for one or al of these options. The default statuses that are already
checked are: Open, Pending and Closed. Y ou can click in these boxes to uncheck
any status.

To continue to display the DOR data, follow this step:

Step Action

3 Select a Status if you want to change the default statuses.

There are a number of combinations that you can choose including the following
status scenarios:

Scenario 1. If you select the Open and Pending statuses, you will view all suspense
records/el ectronic consult records (CPRS orders) available with a status of Open and
Pending.

Scenario 2: The Starting Date field works with the Closed and Canceled statuses.
If you check either one of these statuses, you can then select the Starting Date to
display these records. (The Starting Date field that you select plus Closed Delayed
records for that period does NOT affect the Open and Pending status record
display.)

Scenario 3: If you select all four statuses, you will view ALL Open and Pending
records. You will also view the Closed and Canceled records beginning with the
Starting Date you select ONLY .

Prosthetics Automated Delayed Order Report (DOR) User Manual
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Select the SSN Range

SSN fields

Steps

SSN range

June 2003

Y ou must have an SSN rangeto view DOR data. Thereisa Starting SSN and an
Ending SSN field box. Thisisarange of patient Social Security Numbers by the
last two digits. When you enter arange, it will display electronic consults or manual
suspense entries within that range.

If your workload is categorized by the SSN for a specific Purchasing Agent, then you
can display entries that are assigned by one Purchasing Agent at atime.

Note: Enter arange of 00 to 99 to view all Purchasing Agents' SSNsfor all patients.

To continue to display the DOR data, follow this step:

Step Action

4 Enter the SSN range of the patient display (mandatory).

= Delayed Order Report . .. You are logged onto brokerserver = |E||1|
File Select & Display Yiew Help

Please select ... a sice: NG| @ astarting vate: IEIEET|

The Status: [ Open B Cancelled
| Pending & Closed The last two digits of the . .. Starting S5N: E . . . Ending 55N: E

| ‘Dlvdlstatus_JTvpe lstation |create Jist action [0.5 le~o Jio-2ala0-s0]o0+ iok [paeription _Jpatied _Jssu

402319 | 6rDOR Detail | Total Number of Records > | 0 3¢ Excel | &3 Refresh |
&a" CPRS | &d" Pending Calc | Total Humber of Delayed Orders -> 1] @ Print | x Clear |
&' Request | Percent of Delayed Orders -> | 00.00 @ Menu |

|Press to DISPLAY the requested data

Prosthetics Automated Delayed Order Report (DOR) User Manual 7
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Display the Data

Data display

Steps

Sizing and
Sorting
columns

Delayed Order
Report window

The data displayed are manual suspense and all other consult entries. You'll notice
columns with a breakdown of days of 0-5, 6-9, 10-29, 30-89 and 90+ columns.

These columns display the total number of days old by category within the
breakdown of the columns. |t does NOT display the total number of instances of
records (manual suspense entries or electronic consults via CPRS orders).

To continue to display the DOR data, follow this step:

Step Action

5 Once you have the desired criteria, click the Display button. (Y ou can also
double click arecord to view the Request window.)
Shortcut: Pressthe <Alt> key + <D> key.

Columns are sizable on this window, but hot movable. To resize a column, you can
place the cursor on the column header borderline until you can view the double-
headed arrow. Then click and drag the column until it is the size you want.

To sort the columns, click the column header and the data will redisplay in ascending
or descending order. Note: Due to some records not having a 1% Action date,
sorting by this column will not sort in date order.

== Delayed Order Report . .. You are logged onto DEY
A Starting Date: 6/ 4/2003 =

~=lolx]

File Select & Display View Help

Please select . . . A Site: ‘

The Status: & Open Bl Cancelled
& Pending & Closed

Or ... All Sites:[7l

/Status

YES PENDIMG | MAMUAL 03/20/2001 |12/18/2001 0 a a 0 195 | BOF 1
YES PENDIMNG 06/08/2001 08/22/2001 0 a 0 ED 1 DESCRIPTION OF APPLIAN BOF 1
YES PENDIMG | MAMUAL 08/29/2001 09/19/2001 0 a 1] 0 3 TESTINGPCE BOF 1
YES PENDIMG MAMUAL SO0 07/23/2002 01/08/2003 0 a a a MI DIABETIC SHOES, BLACK TES|O
MO PENDIMG |MAMUAL SO0 05/01/2003 05/01/2003 0 a a 1] 0 0 DESC OF ITEM LIKE ORYG MaF 1
YES PENDIMG |CLONE 508 09/22/2003 02/18/2004 0 a a 0 a BOF 1
YES PENDIMG | MAMUAL 12/08/2003 03/24/2004 0 a a D 3 TEST VILE 2
Mo PENDIMG | MAMUAL 02/18/2004 02/18/2004 0 a a a a 0 TESTIMGITEM BOF 1
Mo PENDIMG | (CLONE 14100 06/10/2004 06/14/2004 2 0 0 0 0 2 EYEGLASS R VILE 2
YES OPEN MAMNUAL 0 a a 0 0 ITEMLISTED TES|O
YES OPEN ROUTIMNE 505 05/22/2001 |08/23/2001 0 a a 67 0 3 ROES'OKAY NO COMNECT BOF 1
YES OPEN MAMNUAL 04/16/2002 0 a a 1] 1 BOF 1
YES OPEN MAMNUAL 041712002 0 a a a mﬂ ITEM L TES|3
YES OPEN MAMNUAL 04/17/2002 0 a a 1] m o ITEMZ TES|3
YES OPEM CLOTHING 500 07/09/2002 1] o] o] o 579 il MEXT ITEM FOR PURCHASE BOF 1
YES OPEM MARUAL 500 07/09/2002 a o] o] o 579 il SWHEELCHAIR, MANUAL BOF 1
YES OPEM MARNLAL 07/22/2002 1] o] o] o 570 o] TEST MAMNUAL TES 3
YES OPEM MARUAL 500 06/19/2003 1] a a a a SWHEELCHAIR, MANUAL WIT DAk 4
YES OPEM MARUAL 500 071232002 a a a a m 1 HOSPITAL BED, RAILS PL DA 4L|
402319 | 4< DOR Detail | Total Number of Records > | 167 3 Excel | £ Refesh |
&7" CPRS | &d" Pending Calc | Total Humber of Delayed Orders -» | 147 Cﬁ Print | x Clear |
éd" Request | Percent of Delayed Orders -» I 92 45 @ Menu
Continued on next page
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Display the Data, Continued

Menu, Refresh
and Clear
buttons

Column titles

The Menu button returns you to the Prosthetics Main M enu window where you can
open additional applications at the same time. The Refresh button resets (recalls)
the data if you had made some column sizing changes. It isthe same as clicking the
Display button again. You can use the Clear button to blank out the window and
start over with new display criteria.

Below are the header titles of each column and a description of each.

Column Description

Dlyd The Delayed column will display either aY es or No as to whether the record is delayed
or not. You can sort on this column by all “Yes’ records or al “No” records by clicking
on the column.

Status The Status of the record is either Open, Pending, Closed or Cancelled. Records with an
Open status are shown in blue.

Type Thisisthe Type of record - Manual Suspense entry or Routine Consult (electronic
orders via CPRS including Eyeglass, Contact Lens and Home Oxygen orders).

Station Thisisthe Station I dentifying number.

Create The Create dateis the date that the record was created.

1% Action The First Action date is the date that initial action was taken on the request and the
status changed from Open to Pending.

0-5 The number of days (0-5) that an order record is not delayed.

6-9; 10-29; These columns of number ranges designate the number of Workdays within these

30-89; 90+ ranges that arequest has been delayed. Thisdoes NOT include Saturdays and
Sundays nor Holidays. This also designates that the record isin a Pending status. Any
record over 5 daysis highlighted in red with yellow numbers.
Note: The numberslisted in each row for arecord designate the number of days NOT
the number of record instances.

Lnk The Link column designates how many items that were linked to that record. It could
be a zero or anumber.
Note that if the status is Closed, and thereis azero in the Link column, then those
records were never linked.

Description | Thisisthe description of the request.

Patient The patient name is displayed.

SSN The Social Security Number for the patient is displayed.

Yellow and Red Records that have a delayed date beyond 5 days will have the number of daysin

fields

June 2003

yellow and the block will be highlighted in red.

Records with 0-5 days will have the number shown in bold print.

Prosthetics Automated Delayed Order Report (DOR) User Manual
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View DOR Calculation Detall

DOR Detail Y ou can view the DOR calculation detail for the range of consults and manual

button suspense entries that you displayed. When you select the DOR Detail button, it
doesn’'t matter what statusis checked because the calculation looks at al the Open,
Pending and Closed records from the starting date you selected.

Number of Y ou can view the total number of Manual suspense entries that are in Open,

MANUALS Pending or Closed status. Thosein the 6-9 or higher columns show the onesthat are
Delayed.

Number of Y ou can view the total number of electronic Consults (that were not entered

CONSULTS manually) that are in Open, Pending or Closed status and have not had any action
taken on them. Thosein the 6-9 or higher columns show the ones that are Delayed.

SUB TOTAL The SUB TOTAL row totals the number of Manual suspense entries + the total

wnber of all other consults.

== Calculation Detail

DOR
Cal CU|atIOn . Dehyefl Order Pegly=i
Detail window : : ;

=10l x|

Days -> 0-5 69 10-29 30-89 90+ Total

SOy [ms] [ee] [5] Number of MANUALS -> [ 173+ 78 +[ 97 +[ 15 +[ 660 =[ 4023

o . : : - . er of COMSULTS > | 161 +| 15 + 1+ ] +| 521 =| 598
0-5 E-9 10-29 30-89 90+
Days to fist action SUB TOTAL -» | 334 +] 53 4] 98 4 15 +/ 4181 =[472
a Minus PENDING before 6/3/2002 : And the Create to 1st Action Dateis > | 129+ 54 +] 3 +] 11+ 3 =[ 290
>

TOTAL DELAYED ->| 33 + 5+ 4 +| 4178 =| 4226
Total of the SUB TOTAL | 4721

Minus the TOTAL PENDING before 67372002 - | 290

TOTAL DELAYED I 4226 divided by | 4431 X100 Equals PERCENT DELAYED -)|95.3?

@Elinl |
Minus Thisrow displays the number of consults that have had an initial action taken on it
PENDING (starting with the date you selected in the calendar for the starting date which is

shown here by 1/1/2003) and put into a Pending status.

This number is subtracted from the subtotal for the Total Delayed row below that.

Continued on next page
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View DOR Calculation Detail, continued

TOTAL
DELAYED

DOR
Calculation
Detail window

The TOTAL DELAYED iscalculation that adds the total number of Manual
Suspense records + the total number of all other consults and subtracts the number of
consultsin a Pending status (Pending from before the Start Date sel ected).

¥ Calculation Detail 10l =|
Delayed Order Analysis
; ; ; [4175 |
N R N [s7e] Days> 05 69 1029 3089 90+  Total
5000 ) Number of MANUALS > | 173+ 78 +] & +] 15 +[ 3680 =[ 4023
il n L = L . lumber of CONSULTS > | 161 +| 15 + 1+ 0+ 521 = 698
0-5 5-9 10-29  30-89 0+
Darys to fist action SUB TOTAL -» | 334 +] 53 4] 98 4 15 +/ 4181 =[472
Minus PENDING before 6/3/2002 : And the Create to 1st Action Date is > | 129 +| 544 934 M +| 3 =] 290

> TOTAL DELAYED »| 239 + 5+ 4 +| 4178 =| 4226
Total of the SUB TOTAL | LIAI

o
Minus the TOTAL PENDING before 67372002 - | 290

— P

Total of Sub
Total

Minus Total
Pending

TOTAL —
DELAYED

Percent
Delayed

June 2003

» TOTAL DELAYED I 4226 divided by | 4431 X100 Equals PERCENT DELAYED -)|95.3? -

5 Print |

The Total of the Sub Total field includes. 1) the total from the Sub Total above

(third row), 2) all totals of Manual Suspense entries and 3) all other electronic
consults.

The next row shows the calculation for the Total consults minus the Pending
consults from the starting date that you selected.

The TOTAL DELAYED field is shown.

This displays the Total Delayed from the grid above (any greater than 5 days
delayed) divided by (the result of the total Sub Total minus Total Pending as of
1/1/03) and multiplied by 100. Thisisthe percentage delayed.

Thefinal calculations above, this equals the Per cent Delayed (shown as 95.37%).

Continued on next page
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View DOR Calculation Detail, continued

Scenariosbelow The scenarios below describe different timelines when orders are received at

Scenario 1

Scenario 2

Scenario 3

Scenario 4

June 2003

different times of the month and if they are delayed. Then it will explain which
month’s Calculation Report where the data will appear.

An order isreceived on Tuesday, June 3rd and is changed to Pending or Closed
status on Friday, 6/6. Thisis not adelayed order and would appear in the June
Calculation Report as an order received.

An order isreceived on Tuesday, 6/3 and is changed to Pending or Closed on
Wednesday, 6/20. Thisisadelayed order and would be included in the June
Calculation Report as a delayed order.

An order isreceived on Thursday, 6/26 and is changed to Pending or Closed on
Tuesday, 7/15. Thiswas not a delayed order in June; however the order isincluded
in the June Calculation Report, because it was received in June. Since it took greater
than 5 days to change it to Pending or Closed, it would also be included in the July
report as a delayed order and would be included in the calculations.

An order isreceived on Thursday, 6/26 and changed to Pending or Closed on
Monday, August 4™. Thisis not adelayed order in June; however, the order is
included in the June Calculation Report, because it was received in June. Sinceit
took greater than 5 daysto change it to Pending or Closed, it would be included in
both the July and August report as a delayed order and would also be included in the
calculations.

Continued on next page
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View DOR Calculation Detail, continued

Print button

Print Preview

June 2003

Y ou can print the DOR Calculation Detail data by clicking the Print button. A

Print Preview pane will display that allows you to zoom in, scroll forward/

backward, print, save the data, or open/load a new report.

Click the Close button to return to the DOR Calculation Detail window.

& Print Preview 18] x|
BEE < 1 |ES|EE e
Delayed Order Report - Calculation Details
Source: SSCSL 6/5i2003
Site: ALL COpen-Yes Cancelled - No Starting SSM: 00
Start Date: 67372002 Pending - Yes Closed -Yes Ending SSM: 99
Delayed Order Analysis
8,000+~ : : :
ao |
i ; Days> 06 68 1029 3089 90+ Total
205
2000+ Nurrber of MANUALS = 173 + 78 + 97 + 15 +36680 = 4023
. _
e A e MNurmber of COMSULTS = 161 4+ 104 1 4 04 521 = 698
PRI Sub TOTAL > 334 4+ 63 4+ 08 4+ 15 44181 = 4721 &
Minus PENDING before B/3/2002 @ And the Create to st Action Dateis-= 128 + 54 4 83 4+ 11 4+ 3= 290
Total Delayed > 39 4+ 5 4 4 44178 = 4228
Tatal of the SUB TOTAL 4721
Minus the Total of the PREYICUS PENDING 290
TOTAL DELAYED 4228 divided by 4431 X 100 Equals PERCENT DELAYED > a5 .37
Notes:
I =]
0% |Page 1 of 1
Prosthetics Automated Delayed Order Report (DOR) User Manual 13
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View Pending Calculations

Pending Calc
Button

Pending status
consults

Pending
Calculations

Print button

Excel button

Close button

June 2003

Click on the Pending Calc button on the DOR window and the window displays

based on the selection criteria of this window.

The Pending Calculations window displays the total number of Workdays with the
total number of Pending records since an initia action was taken onit. These

records are categorized into columns by the number of Workdays it has remained in

a Pending status.

The calculation used to display these Pending status records is from the First Action
date (not from Creation Date) to the current date. Thisisatool to help managers
monitor their consults and manual suspense entries that have been Pending for an
extended period of time.

= Pending Actions Calculation

Stati

500
500
505

14100

Only records in Pending status: D aps from 12t Action Date to Today's Date

06/08/2001 08/22/2001 0
08/29/2001 |09/19/2001 0
07/23/2002 01/08/2003 0
05/01/2003 |05/01/2003 0
09/22/2003 02/158/2004 0
12/08/2003 |03/24/2004 0
02/18/2004 02/18/2004 0
06/10/2004 |06/14/2004 0

Daysz Pending -> 0-5

808
758
449
370
163
135
163

DESCRIPTION OF APPLIAN
TESTING PCE

DIABETIC SHOES, BLACK
DESC OF ITEM LIKE QXYG

TEST
TESTIMG ITEM
EYEGLASS Rt

6-9 10-29

30-89 90+

PROPAT OO0-
PROpAT OO0-
PROPAT DOO-
PROPAT  0OD-
PROPAT 00O-
PROPAT 1000-

Total

Total PEMDING from the 1st Action Date to Today's Date is -> | o+ | o+ I 0+ | 1 +| 8 =| 9

gﬂ LCloze |

gﬁ FPrint |

EE Excel |

display the Print dialog box.

The Print button allows you to print the Pending Action Calculations and will

Y ou can send this datato MS Excel by clicking the Excel button. It will launch the
application and display the data at the same time.

To exit, click the Close button or thelil button in the top right-hand corner.
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View 2319 Information

View 2319 — Patient Demographics

Introduction The View 2319 button displays the 10-2319 Prosthetic patient records. Thetitle bar
displays the patient name and SSN. Here are the windows of information that you
can view from the patient’s 2319:

Patient Demographics

Clinic Enrollments/Correspondence
Entitlement Info

Appliance Transactions

Auto Adaptive Info

Critical Comments

HISA Information

Home Oxygen Items

ONOORWNE

Note: Usethe <Alt> key and the number to toggle to different tabs.

Demographics  You can view the patient demographics for the veteran. Thisincludes: Name (in red

data if deceased with Date of Death listed above the Date of Birth and the age field will
not display), address, next of kin, emergency contact information, veteran benefits
and eligibility (former Prisoner of War (highlighted in blueif “Yes’), Aid &
Attendance, service connected, non-service connected, etc.).

1. Patient i vi PROSPATIENT, ONE_SSH: 000-00-0001 : ]3|
Dernogr a.phl cs 4. Appliance T.ransactlons . | 5. Auto Adaptive Info I &, Critical Comments I 7. HISA Information I . g, Home Ouygen I
. 1, Patient Demographics 2. Clinic Enrollments/Correspondence I 3. Entitlement Infa
window
PROSPATIENT. ONE  pate of Death: [5EF 7 20025120036 Benefits & Eligibility
Addiess: [717 anv sTREET DOE: [INEEAEE Claim #: [77777777
i Patient Type: [ACTIVE DUTY |
City: [EATTLE CREEK Sex [FEMALE atient Type: JACTIVE DUTY
State: [MICHIGAN Race: | Period of Service: [NAYY, MARINE-ACTIVE DU
Zip:[asmr Religion: [BAFTIST Pi Eligibility Code: [SHARING AGREEMENT
; i fiec?: [PENDTNG VERTFIEATION —
Phone: [ssssssssss Marital Status: [MARRIED Eligibilty /erified?: [PENDING VERIFICATION
P.0.w.: 53
Caunty: [CALHOUM S5M:[123-432343 5

Receiving A %4 [vES

Next of Kin Emergency Contacl el E5
Mame: [RELATIVE Name: [ Wi Pension: W
Address: [1212 street Address: | W, Disability: [YES
City: [BATTLE CREEK. City: | Tatal Annual smount [ 30,01
State: [MICHIGAN State: [ Disability Code: [4MP/LAE-SC
Zip: |49015— Zip: I— Dizabilities:
Phone: IW Phone: I— - Disability alsc «
Relation: IMDTHEH Relation: I LS55 OF ALL TOES 0

LOSS OF FIELD OF YISION 0 N

THIGH, AMPUTATION OF:UPPER. THS0

;ﬂ Lloze | BOME INFLAMMATION 1} LI

June 2003 Prosthetics Automated Delayed Order Report (DOR) User Manual 15
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View 2319 - Clinic Enrollments/Correspondence

Window
description

2. Clinic
Enrollments/
Correspondence

Exit

June 2003

This second tab details clinic enrollments and correspondence for the veteran. This
includesthe following: thelast movement actions (i.e., hospital admissions and
discharges), clinic enrollments, pending appointments and correspondence letters.

Note: Due to some records not having a 1% Action date, sorting by this column will

not sort in date order.

PROSPATIENT, ONE SSH: 000-00- 0000

5. Auto Adaptive Info |
2. Clinic Enrollments/Correspondence

4. Appliance Transactions 6, Critical Comments |

1. Patient Demographics
Last Movement Actions

7. HISA Information

=]
8. Home Cixygen I
3. Entitlement Info

Action Type: [DISCHARGE Ward: MICL Action Type:  [ADMISSION Wiard: MIC
Date: |SEP 4,2002@12:00:36 Phys: |PROSPROVIDE,ONE Date:  |FEE 16,1995@09:35:45  Phys: [prosprROVIDEONE
Type of Move: [DEATH Diag: |sENSITIVE Type of Move: [DIRECT Diag: |sENSITIVE

Clinic Enrollments
Total -0

- Clinic

Pending Appointments

S Appt, Datef Time Clinic Skatus
Total -0

MOTHING TO REPORT

A Type of Letter
PRESC. EXPIRY
PRESC, EXPIRY
HO 30 DAY TEST

Letters on File

Total - 4 PROSBEMPLOYEE,ONE
PROSEMPLOYEE, ONE
PROSEMPLOYEE, ONE

TEST FROSBWPLOYEE,ONE

;ﬂ Lloze |

DEC 08, 2000
JUL 50, 1997

To exit, click the Close button or thelil button in the top right-hand corner.
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View 2319 - Entitlement Information

Window
description

3. Entitlement
Info

Exit

June 2003

The third tab details entitlement and loan information for the veteran. Thisincludes

the following: PSC Issue Card, clothing allowance, items on loan, and items
returned.

= ¥iew 2319 PROSPATIENT, TWO SSN: 000-00-0002 _I_I- m] 1'
4. Appliance Transactions 5. Auto Adaptive Info 6, Critical Comments 7. HISA Information | 8. Home Oxygen |
1. Patient Demagraphics 2. Clinic Enrollments{Correspondence 3. Entitlement Info

Not available in this version

To exit, click the Close button or thelil button in the top right-hand corner.
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View 2319 — Appliance Transactions

Appliance The Appliance Transactions tab of the View 2319 window displays all transaction
Transactions history for aveteran. The Date column is the date of the PO. Columns are re-sizable
on thiswindow (not movable). The total records found displays at the bottom.

Note: Due to some records not having a 1% Action date, sorting by this column will
not sort in date order.

Steps To view the Appliance Transactions detail, follow these steps:
Step Action
1 Select atransaction by clicking on it to highlight it.

2 Click the View Detail button below to display the appliance details.
(Y ou can also double click arecord to view the details.)

4. Appl |ance 1. Patient Demographics 2. Clinic Enrallments/Carrespandence 3. Entitlement Infa
- . 4. Appliance Transactions 5. Auto Adaptive Info 6. Critical Comments 7. HISA Information 8. Home Oxygen
Transactions | !

SDate Oty [Item Typ |vendor Skation Serial HCPC  |Total Cost

03{17/00 |1 |PUJDEL CHG % | VENDOR OME 5.6 | |watoo

01/21/00 |1 BED WEDGE-TORSO-GLOBAL COMFORTPILI | WEMDOR, TIAD 516 E031S | 42.01
12/16/99 1 PUMP-ALT PRESS-ALPHACARE HMSS 1 WENDOR,THREE 516 ACOZ3915  EO182 | 169.60
12/16/99 1 PAD-ALT PRESS-74%31 DEL BUBBLE-AOPS |1  ENDOR,THREE 516 EO151 | 108.00
12/16/99 |1 CUSHION-ROHO-HIGH PROFILE-SXSCELL R *VENDOR FOUR 516 IR99C E0192 | 218.23
03{19/99 |1 PUJDEL CHG ¥ WENDOR,OME 516 E1340  35.00
03{19/99 |1 BRODA CHAIR I YENDORFIVE 516 1701-0835¥0 E1031 | 0.00

01/20/99 |1 MATTRESS-GCSS GEL/FOAM OVERLAY I YENDORTWO 516 E0185 | 97.46
09/09/98 |1 FOOT-SUPPORT-FOR-WC-PLASTIC W/VELCT | VENMDOR SIX 516 KO108 | 51.00
09/09/98 SHIPPING ¥ WENDOR SIX 516 34.95
07{16/98 |1 HEATPACK-HAND HELD-STAR I WENDOR SEVEN 516 E0235 | 15.50
08{27/97 |1 GUARD-BUNION-LG 1 VENDOREIGHT 516 14862 L3649 18.50
06{02/97 |1 | CUSHION-ROHO-LOW PROFILE-GXSCELL 1 | **VENDORFOUR 516 E0192 | 218.23
04/09/97 |1 CUSHION-JAY 2-18¥18 I **VENDORMINE 516 E0192 | 225.00
04/09/97 |1 |WHEELCHAIR-9XT-18%16-ELEV FR 1 VEMDOR.TEN 516 97C09253  KOODL | 364.99

Total records found - 15

[EX, Wiew Detail |

Exit o | EI _ _
To exit, click the Close button or the button in the top right-hand corner.

Continued on next page
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View 2319 — Appliance Transactions, Continued

Steps

Appliance
Transaction
Detail

Exit

June 2003

To continue to view the Appliance Transactions detail, follow these steps:

Action

3 The Transaction Detail window is shown below.

4 Click the Close button to return to the Appliance Transaction window.

& Transction Detail

=10l x|

Appliance Item Lab Date: [J&N 21,2000
Appliance: [EED WEDGE-TORSO- COMFORT PILLOW Lab Cost: | Work Order: [
Description: | Material Cost: | Transaction:I—
HoPcs: JEoms | aw i Labor Hrs: I_ Type Trans: W
HCPCS Desc: [BED ACCESSORY BRO/TEL/SUPPRT LaborCost [ Fom Type: [STOCKGS0E
ICD-8Cede: [ CPT Modifer: | Disabily: [SC/OP L — Intiator: [FROCTORANITAT
Irvent Paint: | Completed: [ N L —
Source: |COMMERCIAL
Dieliver To: I— Delivery Date: m O Caet I gank futh
Recv Sta: | Restor Code: I— Total Cost: [§42 01
Retun Stat: [ Lab Remarks
Remarks: [MAILED CERTIFIED TO BOGA CIEGA HU Remarkz: |

IFCAP Yendor Historical Data

Name: [\ENDOR TWO Name: [
Add: 5328 CEMTRAL &VE Add: |
City: |ST PETERSELURG Ciy: |

State:  [FLORIDA Zip: [33707 State: |

Phore: |32?-1 918
Track #: I

Zip: |

Phone: |

ltem: |

Station: |

Extended Description

To exit, click the Close button or thelil button in the top right-hand corner.
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Patch RMPR* 3*59

19



View 2319 — Auto Adaptive Info

Window
description

5. Auto
Adaptive Info

Exit

June 2003

Thefifth tab details the Auto Adaptive information.

PROSPATIENT, TWO SSH: 000-00-0002 = IElIlI
1. Patient Demographics | 2. Clinic Enrollments /Correspondence 3. Entitlement Info
4, Appliance Transactions 5. Auto Adaptive Info | 6. Critical Comments 7. HISA Information 8. Home Oxygen

Not available in this version

To exit, click the Close button or thelil button in the top right-hand corner.
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View 2319 - Critical Comments

Window
description

6. Critical
Comments

Exit

June 2003

The sixth tab details any critical comments recorded for the veteran.

File  Select i henlav View  Heln

=10l x|

é Yiew 2319 PROSPATIENT, THREE : 000-00-0003
1. Patient Demographics I 2. Clinic Enrollments/Correspondence I 3. Entitlement Info
4. Appliance Transactions I 5. Auto Adaptive Info 6. Critical Comments | 7. HISA Information I 8. Home Oxygen

4-4-04; AE |tr {steno 53, 10-1394 to vet, SP
6-21-94: AE LTR (STENO I, INVOICE TO HOME MEDICAL.SP
11-30-95: AE LTR (STEMNO I); INVOICE TO HOME MED, SP

6-97: AE ltr {steno 5); 10-1394 to vet, SP
1-11-99,0RDER. FOR HOSPITAL BED, TRAPEZE, HUNTLEIGH MATTRESS & PUMP, CHAIR

< |

;ﬂ Lloze |

|

2-12-96: HOME MEDICAL ADVISED TO PROCEED WITH CHANMEL MODIFICATIONS TO VET'S WAN PER QUIOT
3-17-97: LTR ADVISING YET OF AE ITEMS ON LOAN WHICH MEED TO BE REMOYED BEFORE HE CAN DISPO
9-1

To exit, click the Close button or thelil button in the top right-hand corner.
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View 2319 — View HISA Information

Window
description

7. HISA
Information

Exit

June 2003

The seventh tab details the HISA (Home Improvement Structural Alteration)

information including the date, quantity, item, type, vendor, station number, serial,
HCPCS Code and cost of the item ordered.

Note: “HISA Information” is the new name for this window; it used to be “ Add/Edit
Disability Codes.”

Note: Due to some records not having a 1% Action date, sorting by this column will
not sort in date order.

Step Action

1 Select atransaction by clicking on it to highlight it.

2 Click the View Detail button below to display the HISA information
details. (You can also double click arecord to view the details.)

£ view 2319 PROSPATIENT. TWO  SSN: 000-00-0002 =1ol x|
1. Patient Demographics 2. Clinic Enrollments /Correspondence | 3. Entitlement Info I
4, Appliance Transactions 5. Auto Adaptive Info 6. Critical Comments Z. HISA Information | 8. Home Oxygen

Typ |vendor i i Total Cost

[EX, Wiew Detail | Q Close | Total records found - 0

To exit, click the Close button or thelil button in the top right-hand corner.
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View 2319 — Home Oxygen

Window The eighth tab detail s the Home Oxygen information including the date, quantity,
description item, type, vendor, station, serial, HCPCS Code, and total cost of the item(s).

Note: Due to some records not having a 1% Action date, sorting by this column will
not sort in date order.

Step Action

1 Select atransaction by clicking on it to highlight it.

2 Click the View Detail button below to display the Home Oxygen
information details. (Y ou can aso double click arecord to view the

details.)
§_ Home TRL PROSPATIENT, FOUR SSH: 000-00-0004 =l
Oxygen 1. Patient Demographics I 2. Clinic Enrollments /Correspondence I 3. Entitlement Info |
4. Appliance Transactions 5. Auto Adaptive Info I 6, Critical Comments I 7. HISA Information 8. Home Cxygen

Date gy [1tem |1y [vendar |station  [serial  [HcPe Tatal Cost

09/25/00 1 EYEGLASSES I SEMDOR EIGHT S00 A4500 50,00

0zf14/00 1 EYEGLASSES I SEMDOR ELEYEN 499 SI1z5 50,00

01f27j00 1 EYEGLASSES I SEMDOR ELEYEN 499 A4500 50,00

01/20{00 I |vENDOR ELEVEN T E

11f01fo0 1 BEEF-R.OUND{ TOP{INSIDE/FRZN I SEMDOR, TWELYE S00 E1383 5.00

Q Close | Total records found - 5
Exit o | EI _ _
To exit, click the Close button or the button in the top right-hand corner.
View Detail When you select arecord and click the View Detail button, the following window
displays as shown on the next page
Continued on next page
June 2003 Prosthetics Automated Delayed Order Report (DOR) User Manual 23

Patch RMPR* 3*59



View 2319 — Home Oxygen, Continued

View Detalil
button

Transaction
Detail window

Close button

June 2003

After clicking the View Detail button on the Home Oxygen window, the following

window displays for the patient.

To exit, click the Close button or thelil button in the top right-hand corner.

£ Transction Detail =10|
Appliance Item Lab Date: [JaN 20, 2000&(
Appliance: [EYEGLASSES Lab Cost: | Work Order [
Deseriptian: | Material Cast: | Transaction: [PEOT07
HCPos: [a4500 0 w1 Labor Hrs: [~ Type Trans: [INITIALISSUE
HCPCS Dese: [BELOW KNEE SURGICAL STOCKING Labor Cost [~ Form Type: [CREDIT CARD
ICD-9Code: [ CPTModiier | Disabiiyy: [SCAOF Teeh [ Intiater: [prospROVIDER THREE
Irwrent Paint: | Completed: [ Site: [FUFFORT IR
Source: |COMMERCIAL
Deliver To: :— Delivery Date: m Orthe Code: I ank futh
Recy Sta: | Restor Code: I— Tatal Cost: [$50.00
Returm Stat; I— Lah Remarks
Remarks: | Remarks: |
IFCAP Yendor Historical Data
Mame: [\ENDOR. ELEVEN Mame: | e [
Add: [33333 sdd: | Statiors [
City: [DFLANDD City: |
State: JFLORIDA Zip: [11111 State: | Zip: |
Phone: l— Phone: I—
Track #: l—

Extended Description
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View CPRS

View and Manage the DOR

Function
description

The View CPRS button from the DOR window allows you to view all the consult
data on the View CPRS window as shown below. Thisisthe same dataasin the
electronic Consult - Suspense (SU) M enu feature where you can enter CD for the
CPRS Display.

View CPRS
window

¥= view CPRS

Current Pat. Status: Outpatient

Order Information

To Service: ETEGLAZS REQUEST

From Service: SPEECH PATHOLOGY

Bequesting Provider: PROSPROVIDER, TWO

Service is to be rendered on an OUTPATIENT basis
Consultant's choice
Poutine

Orderable Itemw: ETEGLASS REQUEST

Consult: Consult Recuest

Provisional Diagmosis: Ocular Hypertension (365.04)

Leason For Redquest:

EYEGLASE RX:

[DISTANCE]

Sphere Cylinder Prism

Addition Height Type Width P} Far PDr Near PIr Near Inset
Total Inset

[FRAME SELECTION] OFRDEEING INFORMATION-
Frame MName: OBELICATION #:
Colox: TOTAL COEST

Close button

To exit, click the Close button or thelil button in the top right-hand corner.

June 2003
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View Request

Function
description

View Request
window

Close button

June 2003

When you click the View Request button on the DOR window, the View Request
window displays as shown below. This provides the display of the manual suspense
entry for the patient.

Note: You can also double click on arecord in the DOR window grid to display this
View Request window.

4 Yiew Request 10l x|
Requestaor: I Order/Suzpense Date: IDE;’DQ;’DD
Initial Action Drate: I
Suspended By |41 DUY UDSL B
Completion D ate: I
Description of ltem/Services
long handle bath sponge ;I
long shoe hom
buttonaid
dreszing stick
bath tub railz
Initial Action Mote
WOTHING TO REPORT ;l
Completion Mate
WOTHING TO REPORT ;l

To exit, click the Close button or thelil button in the top right-hand corner.
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Save as an Excel File

Excel Button

M S Excel data

M S Excel

Print the data

June 2003

The Excd button on the DOR window will automatically launch the Microsoft
Excel software program for you. It converts the data that you have selected to
display into the Excdl file as shown below.

Shortcut: Pressthe <Alt> key + <X> key.

This feature creates atemporary Excel .CSV filein the C\NPPDDownL oad folder
where the fileistemporarily held. The file nameis based on the site + the beginning
and ending range of the patient’s SSN. Y ou can save this as an Excel file using the
Save As option from the File Menu. When you exit the Prosthetics Main M enu
window (VISTA suite), the .CSV file will be deleted.

Example: The DOR_9 50 _60.csv filename includesthe Site ID # or “ALL” and
SSN range.

laix
E] Fle Edt View Insert Format Tools Data Mindow Help  Adshe POF Type aquestionforhelp =/ = @ X
DEeESH SRy 468 - @& = -4 ) -8 2 -0 -|B Z U B L -d-A- 2
i @ ¥ e
T " .
Al - #& Dlyd
A [ B [ ¢ [ o [ E [ F [ & [ H T T T[T J T ¥ [ L 7] b [N o] 1
| 1 [Dlyd !Statua Type Station | Create 13t Action|0~5 5~9 10~29 30~62 a0+ Lnk Description Patien SSN
| 2 [YES OPEM  MAMNUAL 372042001 1] ] i] i} 212 1 BOP,E101-
| 3 |YES PEMDING MANUAL 32072001 | wRRHE 1] ] i] i} 195 2 BOP,E101-
| 4 |YES OPEN MANUAL 5872001 1] 1] a a 884 0 ITEM LISTED TEST, 085-
| 5 |YES OPEN ROUTINE 508 5/22/2001 B/23/2001 1] 1] a 67 1] 3 ROES 'OKAY'NO (BOP,E101-
| & |YES PENDING B/B£2001 | B/22/2001 1] 1] a 53 1] 1 DESCRIPTION OF BOP,E101-
| 7 |YES PENDING MANUAL 8£29,2001 | 919,2001 1] 1] 15 a 1] 3 TESTING PCE BOP,E101-
| & |YES OPEN MANUAL 4162002 1] 1] a a 639 1 BOP,E101-
| 8 |YES OPEN MANUAL 41752002 1] 1] a a 638 0 ITEM 1 TEST, 333
| 10 |YES OPEN MANUAL 41752002 a 1] a o] 638 0 ITEM 2 TEST, 333
| 11|YES CLOSED EYEGLAS 5000 7/9/2002 2/158/2004 a 1] a o] 416 1 TESTING ITEM DE:BOP,E101-
12 |YES OPEN CLOTHING 5000 7/9/2002 a 1] a o] 579 0 MEXT ITEM FOR PIBOP,E101-
| 13 |YES OPEN MANUAL 5000 7/9/2002 a 1] a o] 579 0 WHEELCHAIR, MABOP,E101-
| 14 |YES OPEN MANUAL 7r22r2002 a 1] a o] 570 0 TEST MANUAL  TEST, 333-
| 15 |YES OPEN MANUAL 500/ 6/19/2003 a 1] a o] 336 0 WHEELCHAIR, MADANG 453-
| 16 |YES OPEN MANUAL 500 772372002 o 0] a o 569 1 HOSPITAL BED, R, DANG 453-
[ 17 |YES PENDING MANUAL 5000 772372002 1/8/2003 o 0] a o 120 1 DIABETIC SHOES, TEST, 088-
| 18 |YES OPEN MANUAL 500 772372002 o 0] a o 569 0 HOSPITAL BED, D MART 123-
|19 |YES OPEN MANUAL 500 772372002 o 0] a o 569 0 TENS UNIT, 4 LEAIMART 123-
| 20 |YES OPEN MANUAL 500 772372002 o 0] a o 569 0 ARTIFICIAL LEG, EMART 123-
|21 |YES OPEN MANUAL 500 772372002 o 0] a o 569 0 HEARING AID MART 123-
|22 |YES OPEN MANUAL 800 772372002 o 0] a o 569 0 STANDARD HOSP MART 123-
|23 |YES OPEN MANUAL 800 772372002 o 0] a o 569 0 TENS UNIT, 2 LEAIMART 123-
| 24 |YES OPEN MANUAL 800 772372002 o 0] a o 569 0 SPECIAL MATTRE MART 123-
| 26 |YES OPEN EYEGLAS 14100 91072002 o 0] a o 634 0 EVEGLASS RX:  BECK 244-
| 26 |YES OPEN MANUAL 4872003 o 0] a o 387 3 FGDF OFGDF DANG 453-
| 27 |NO PENDING MANUAL 5000 5172003 5/1/2003 0 0 a o 0 0 DESC OF ITEM LIk MART 123-
| 28 |YES OPEN MANUAL 87262003 0 0 a o 288 0 DANG 453-
| 29 |YES OPEN CLOTHING 500 872872003 0 0 a o 286 0 GREEN WHEELCHDANG 453-
|30 |YES OPEN AUTO ADA 500 872872003 0 0 a o 286 0 BLUE WHEELCHA DANG 453-
|31 |YES OPEN CLONE 500 872872003 0 0 a o 286 0 PINK WHEELCHAI DANG 453-
|32 |YES CLOSED ROUTINE 449 9/372003 107872003 0 0 28 o 0 1 RO preumonia TEST, 333 =
4 4 » w[\DOR_ALL_20_90 [ | L”J

Y ou can now use any of the features of Microsoft Excel to manipulate your data.
Notice that you may need to scroll to the right to view all of the columns.

Y ou can aso print the datafrom Microsoft Excel. Click the File Menu and the Print
option. See next page for more printing information.
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Print the DOR

Print the DOR
data

L andscape
default

Steps

Print dialog
box

June 2003

Y ou can print the DOR data using the Print button to send this datato your local
printer. You can aso click the File Menu and the Print-Request Grid option, and
the Print dialog box displays. The layout of the print will be the same as the display.
Shortcut: Pressthe <Alt> key + <P> key.

Note: You can select adifferent printer that you have setup to print the detail.

When printing grids, the default is set to print in the Landscape format and then
returns the printer to the prior state.

To print the DOR, follow these steps:

Step Action
1 Click the Print button on the DOR window.
2 The Print dialog box displays.
3 Click the Properties button (to the right of the Name field) on the Print

dialog box if you want to change the page orientation of the printout.
(Optional)

4 Click the OK button.

Print 2 x|
r— Printer
Mame: HF Laserlet 4 Properties... |
Status: Ready
Type: HP Lazeret 4
Whene  LPT1:
Cornment:
— Print range Copies
Lo Murber of copies: |1 3:
" Pages _from:l Eo:l
¥ Callate
" Selection
aK I Cancel
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Appendix A

Using the Menus

Menus

FileMenu

Select and
Display Menu

View Menu

Help Menu

June 2003

Below are the different menus and menu options that are available to be used instead
of the corresponding buttons. Y ou can use these menu options alternatively.

The Help Menu is the only menu that does not have a corresponding button. This
menu leads you to online help through the Contents option. The Section 508 option
is described more in Appendix B.

g [=[ 5]

== Delayed Order Report . . . You are logged onto brokerserver

J| File Select & Display  Yiew Help
Print - Request Grid
1 Or ... All Sites:[g A Starting Date: m
Print - Pending Grid dlled
The last two digits of the . . . Starting 55N: [0 . .. Ending ssn: [EE]

Exicel ¥ Print - Calculation Detail
It Fenaing I Liosed

|_[rvpe station |create Jist action Jo-5 le~o li0-20 |30-50 a0+ Jick |pescription ___[patiert

Refresh
Clear

SSN

Close

=+ Delayed Order Report . . . You are logged onto brokerserver

File | Select & Display Yiew Help
S s L i i | & 32003 =]
Selact Starting Date Chrl+alt+5 Or...allSites:q Rishinnates

Select Status 1 v Cpen FS
PSS N two digits of the .. . Starting SSN: & ...ending ssn: [EE]

Select Starting SSM - Chrl+alE+S

Cancelled F7 » . ] o i
Select Ending 53N CHrkHAIbHE -5 [6~9 [10~29 [30~83 30+ [ink [Description Patient S5y

v Closed F&

Display

= NPPD Delayed Order Report - Yersion 1 Release 1 - 10l =|
File Select & Display | Yiew Help

o core = i ' [ 1/ 172003 =]
Please select . . . [N, Or ... All Sites [ A Starting Date:
The Status: [ 0 RCILEETCES = Display

The last two digits of the . . . Starting 55N: [0 . . . Ending ssn: [EE

VB view DOR Detail

iew Pending Calculations El

e+ Delayed Order Report . . . You are logged onto brokerserver
File Select &Display  Wiew | Help

Contents F1
Please select . . . A Sil . — ﬂ Or ... All Sites:[5 A Starting Date: w
The Status: [ Open Section 508 Ctrl+5 Egisplay
The last two digits of the .. . Starting 5sn: [E . .. Ending ssn: [EEI

[ Pendingiie e Chrla
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Appendix B

Getting Help

F1Key

Help Menu

June 2003

Online Help can be accessed in three methods:

1. Click the Help Menu (located in the upper left corner of the menu bar) and
the Contents option.

2. Pressthe <F1> key.

3. Pressthe <Alt> key + <H> key. (This activatesthe Help Menu, not the
DOR contents.)

= Delayed Order Report . .. You are logoed onto DEY
File Select & Display Yiew Help

Please select .. . ASite: m Or ... All Sites:[7l A Starting Date: m

The Status: [l Open & Cancelled
Wl Pending W Closed The last two digits of the . .. Starting 55N: E . . . Ending 55N: E

[10] 0o
CAMCELLE CLOME 10/01/2003 REASON FOR REQUEST: (
CANCELLE MANLIAL 11/04/2003
CANCELLECLOME 14100 | 08j03/2004 | 08/03/2004 0
CANCELLECLONE 14100 | 05/19/2004 0
CANCELLECLONE 14100 | 05/19/2004 0

402319 | 6rDOR Detail | Total Number of Records > | 6 3¢ Excel | &% Refresh

&a" CPRS | &d" Pending Calc | Total Humber of Delayed Orders -> 5 @ Print | x Clear

&' Request | Percent of Delayed Orders -> | 83.33 @ Menu |
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Activate Section 508 Assistance

Introduction

Steps

Confirmation
message

Exit/Restart
message

June 2003

Y ou can change the colors of the screen to black/white, which is required for Section
508 requirements to be read by visually and hearing impaired veterans.

This feature can be updated from the Help Menu. It provides atoggle to go back
and forth between using the colors or the black/white screens depending on your

needs.

To activate the Section 508 assistance, follow these steps:

Step Action
1 Click the Help Menu, and click the Section 508 option.
Help
Cantents F1
Section 508 Chrl+5
About Chrl+-A
Shortcut: Pressthe <Ctrl> key + <S> key.
2 Click OK on the confirmation message dialog box as shown below.
3 Click OK again to exit out of the system and restart to activate the

changes.

Please EXIT and RESTART the program For the changes to take effect
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